
Advanced Electrical Materials 



www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 2 

DISCLAIMER ddddddddsdadfdfsfsdfsdfd

lease dadfnote that all product, oduct specifications and data detailed in this brochure are subject to change 
without notice to improve reliability, function, design or otherwise. Morgan AM&T B.V. and its affiliates does 
not assume any responsibility for the correctness of this information nor for damages consequent to its use. 
Statements regarding the suitability of products for certain types of applications are based on knowledge of 
typical requirements that are often placed on Morgan products in generic applications 

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 3 

Bitte beachten Sie, dass alle Produkte, Produktspezifikationen und Angaben in dieser Broschüre jederzeit 
ohne Vorankündigung geändert werden können, um Zuverlässigkeit, Funktionalität, Design oder sonstiges 
zu verbessern. Morgan AM&T B.V. und seine Tochtergesellschaften übernehmen keine Verantwortung für 
die Richtigkeit dieser Angaben noch für Schadensersatzansprüche aufgrund deren Verwendung. Aussagen 
hinsichtlich der Eignung von Produkten für bestimmte Anwendungen basieren auf der Kenntnis typischer 
Anforderungen, die bei generischen Anwendungen häufig an Produkte von Morgan gestellt werden.

HAFTUNGSAUSSCHLUSS

fvzelm
Getypte tekst
    



www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 2 

DISCLAIMER 

Please note that all product, product specifications and data detailed in this brochure are subject to change 
without notice to improve reliability, function, design or otherwise. Morgan AM&T B.V. and its affiliates does 
not assume any responsibility for the correctness of this information nor for damages consequent to its use. 
Statements regarding the suitability of products for certain types of applications are based on knowledge of 
typical requirements that are often placed on Morgan products in generic applications 

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 3 

Sicherheit
N.B. Bei der Arbeit mit elektrischen Geräten ist es wesentlich, 
dass grundlegende Sicherheitsrichtlinien beachtet werden, 
z.B. sicherstellen, dass das Gerät komplett potenzialfrei ist, 
bevor man mit der Arbeit beginnt. 

Machen Sie vor der Durchführung von Arbeiten 
zusammen mit dem Gesundheits- und Sicherheits-
beauftragten Ihrer Firma, bzw. Ihres Auftraggeber, kundig,
um sicherzustellen, dass alle örtlichen Sicherheitsvorschriften
eingehalten werden.
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INTRODUCTION

The primary object of maintaining or reconditioning a commutator or slip ring (Collector) is to remove those 
irregularities which lead to impaired brush efficiency and reduced brush and collector life. Collectors should, 
in an ideal world, be smooth and true. A collector that is in bad condition should be either re-ground or 
turned. 

In general, collectors with a Total Indicated Runout (TIR) of 76µm (3 mil) or greater and on a commutator 
with a Maximum Bar-to-Bar Height (MBTB) of 7.6 µm (0.3 mil) or greater needs to be re-ground or turned: 

Regular use of a profiling device such as the MSPro14 will help to confirm whether there is a problem with 
the collector and this should be done at least every six months and if possible every 2 months. Trending this 
information will help better plan maintenance schedules. 
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An acceptable commutator Profile An unacceptable commutator profile 

An acceptable slip ring profile An unacceptable slip ring profile

Therefore congratulations on purchasing the MSPro14 – the new and improved Surface Profiler from Morgan 
Advanced Materials. The MSPro14 is used for: 
 Collector surface profiling and measures TIR, MBTB as well as collector diameter 
 The TIR for collectors is the difference between the minimum height and the maximum height. The TIR is 

also referred to as the ‘runout’ or 'out of roundness'. 
 The MBTB Height for commutators is the maximum height difference between two adjacent bars. The 

MSPro14 can also determine when there are high micas present on Commutators. High Micas occur 
when there appears to be no gap between two consecutive bars. High Micas will be indicated as a bar 
number in the edit recordings dialog window. 

 The MSPro14 takes recordings in what the industry knows as ‘shape’ mode. Shape mode takes readings 
as the sensor moves over the collector surface and using these values it is able to generate a shape of 
the collector. Shape mode records a large number of samples, thus enabling a profile to be recorded 
allowing wear patterns and irregularities to be inspected. 

EINFÜHRUNG
Das Hauptziel der Wartung oder Instandsetzung eines Kollektors oder Schleifrings besteht 
darin, Unregelmäßigkeiten zu beheben, die zu beeinträchtigter Bürstenleistung und zu einer kürzeren 
Lebensdauer von Bürste und Kollektor führen. Kollektoren sollten idealerweise laufruhig und passgenau 
sein. Kollektoren, die sich in einem schlechten Zustand befinden, müssen entweder nachgeschliffen oder 
gedreht werden.

Kollektoren mit einer Rundlaufabweichung (TIR) von 76 μm (3 mil) oder mehr, die sich auf einem 
Kommutator mit einer maximalen Höhe von Lamelle zu Lamelle (MBTB) von 7,6 μm (0.3 mil) oder mehr 
befinden, müssen nachgeschliffen oder abgedreht werden:

Durch die regelmäßige Anwendung eines Profiliergeräts wie zum Beispiel MSPro14 kann man feststellen, 
ob es ein Problem mit dem Kollektor gibt. Das sollte mindestens alle sechs Monate, wenn möglich alle 
2 Monate erfolgen. Mithilfe der Prognosen aufgrund dieser Angaben kann die Wartung besser geplant 
werden.

Zustand
Rundlau-

fabweichung 
(TIR)

Lamelle-zu-
Lamelle-Ab-

weichung

Unterschnitt-
tiefe

NEU unter .0015” 
(38 µm)

unter .0002” 
(5 µm)

0,050” 
(1,3 mm) 

oder mehr

IN BETRIEB unter .003” 
(76 µm)

unter .0003” 
(7,6 µm)

020” 
(0,5 mm) 

oder mehr

REPARAT-
TURBEDÜRF-
TIG

unter .003” 
(76 µm)

über .0003” 
(7,6 µm)

010” 
(0,25 mm) 
oder weniger
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An acceptable commutator Profile An unacceptable commutator profile 

An acceptable slip ring profile An unacceptable slip ring profile
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Angemessenes Kommutatorprofil Nicht angemessenes Kommutatorprofil

Angemessenes Schleifringprofil Nicht angemessenes Schleifringprofil

Daher gratulieren wir Ihnen zum Kauf von MSPro14 – das neue und verbesserte Oberflächenmessgerät von 
Morgan Advanced Materials. MSPro14 wird für folgende Anwendungen eingesetzt: 

• 	 Oberflächenmessung von Kollektoren und Messung von TIR, MBTB und Kollektordurchmesser 

• 	� Die Rundlaufabweichung von Kollektoren errechnet sich aus der Differenz zwischen Mindesthöhe und 
maximaler Höhe. Die Rundlaufabweichung wird auch als “Unrundheit” bezeichnet. 

• 	� Die MBTB-Höhe für Kommutatoren ist die maximale Höhendifferenz zwischen zwei nebeneinander 
liegenden Lamellen. MSPro14 erkennt auch Mica-Höchstspannungen auf dem Kommutator. Mica-
Höchstspannungen treten auf, wenn zwischen zwei aufeinander folgenden Lamellen kein Spalt erscheint. 
Mica-Höchstspannungen werden als Lamellennummer im Dialogfenster Aufzeichnungen bearbeiten 
angezeigt. 

• 	� MSPro14 macht Aufzeichnungen in einem Modus, der branchenweit als ‘Form’-Modus bekannt ist. 
Im Form-Modus werden Messungen gemacht, während sich der Sensor über die Kollektoroberfläche 
bewegt. Mithilfe dieser Werte kann auch die Form des Kollektors erstellt werden. Im Form-Modus werden 
sehr viele Muster und daraus wiederum ein Profil aufgezeichnet, mit dem man das Verschleißbild und 
Unregelmäßigkeiten untersuchen kann.
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 Peak height mode can be selected (in the DASPro14 software) and is where one value per bar is 
displayed – this being the peak height of multiple samples taken across the entire bar. 

 Collected data can be transferred to a PC where it can be analysed in detail using the DASPro14 
Windows based software supplied in the kit. 

The MSPro14 also offers:
 A solid easy to mount sensor that can be fitted to a vast range of holder sizes, and is rugged enough to

cope with extreme enenvironments including vibration  
 Easy to use responsive industrial colour touch screen  
 Optimised sensor head that is not negatively affected by Helically Grooved Slip Rings  
 Zero setting light indicators for easy set up  
 Previous Morgan supplied profiler measurements (.mas files) can be stored and combined  
 Extra extensive memory for storing information and editable on the data acquisition box 
 Comes in a robust carrying case including all attachments 

On/off button (1) 
Sensor lead port (2) 
USB port (3) 
LED display showing 3 different colours: (4) 

Green = Device is on
Orange = Device is on and charging 
Red = Device is off and charging 

Standard Kit Items: 
Included in the MSPro14 package which is supplied in a robust lightweight case including: 
 Data Acquisition Unit (the measuring box) 
 USB stick containing this manual and latest PC software (DASPro14 - Data Analysis Software) 

Sensor
 Protective Sensor sleeve and sensor spacer set 
 USB cable 
 AC power adaptor 
 External Battery 
 G (or C)-Clamp 

Flashlight & pen

12 3 4 
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RECOMMENDATIONS

Read this manual prior to installing the software and using the device for the first time. All instructions 
included in the manual must be followed. 

Remove any loose dirt/debris from the collector surface prior to taking a profile and always ensure that the 
sensor head is clean before taking any readings as this could affect the results of the profile severely. Use a 
clean, lint free cloth for this, for example, spectacle lens cleaning cloths 

The sensor head is a highly accurate piece of equipment, and although constructed to withstand normal 
handling, it should be treated with care at all times. The sensor should always be stored in its supplied 
sleeve when not in use.

When recording a profile, the results will be more consistent when the sensor is mounted as radially as 
possible (ideally ±1°) and when rotated in the direction as indicated in the figure below. 

Under no circumstances should the sensor be clamped directly – it should always be fitted in a holder or 
sleeve and the sleeve held in place with a clamp. 

It is recommended that the sensor is calibrated every 12 months – this can either be done by sending your 
MSPro14 to your local Morgan Sales office or directly to Morgan Advanced Materials Netherlands. 

• �Der Spitzenhöhen-Modus kann (in der DASPro14-Software) ausgewählt werden. Hier wird ein Wert pro 
Lamelle angezeigt, der die Spitzenhöhe von vielen Stichproben darstellt, die über die gesamte Lamelle 
gemacht wurden. 

• �Die gesammelten Daten können an einen PC übertragen werden, wo sie mit der im Lieferumfang 
enthaltenen DASPro14 Software auf Windows-Basis bis ins Detail analysiert werden können. 

MSPro14 bietet außerdem 
• �Solider, leicht zu montierenden Sensor, der für ein breites Spektrum an 

Halterungsgrößen passend und robust genug ist, um extremen äußeren Einflüssen wie Vibrationen 
standzuhalten. 

• �Bedienerfreundlicher industrieller Farbtouchscreen 
• �Optimierter Sensorkopf, der nicht durch spiralförmig gerillte Schleifringe beeinträchtigt wird • Nullpunkt-

Lichtanzeigen für mühelosen Aufbau 
• �Von Morgan zur Verfügung gestellte, ältere Profilmessungen (.mas-Datei) können gespeichert und 

kombiniert werden 
• �Extra umfangreicher Speicher zum Speichern von Informationen; kann im Datenerfassungsfeld bearbeitet 

werden 
• Wird in einem robusten Tragekoffer zusammen mit dem gesamten Equipment geliefert 

Ein-/Aus-Schalter (1) 
Kabelanschluss für Sensor (2) 
USB-Port (3) 
LED-Display mit 3 verschiedenen Farben: (4) 
• Grün = Gerät ist eingeschaltet 
• Orange = Gerät ist eingeschaltet und lädt 
• Rot = Gerät ist ausgeschaltet und lädt

Standardausstattung:
Im MSPro14-Paket enthalten, das in einem leichten und doch robusten Koffer geliefert wird:
• Datenerfassungseinheit (Messkasten)
• USB-Stick mit diesem Handbuch und der neuesten PC-Software (DASPro14- Datenanalysesoftware)
• Sensor
• Sensor-Schutzhülle und Sensor-Abstandsset
• USB-Kabel
• Wechselstromadapter
• Ersatzbatterie
• G- (oder C-)-Halterung
• Taschenlampe & Stift
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 Peak height mode can be selected (in the DASPro14 software) and is where one value per bar is 
displayed – this being the peak height of multiple samples taken across the entire bar. 

 Collected data can be transferred to a PC where it can be analysed in detail using the DASPro14 
Windows based software supplied in the kit. 

The MSPro14 also offers:
 A solid easy to mount sensor that can be fitted to a vast range of holder sizes, and is rugged enough to

cope with extreme environments including vibration  
 Easy to use responsive industrial colour touch screen  
 Optimised sensor head that is not negatively affected by Helically Grooved Slip Rings  
 Zero setting light indicators for easy set up  
 Previous Morgan supplied profiler measurements (.mas files) can be stored and combined  
 Extra extensive memory for storing information and editable on the data acquisition box 
 Comes in a robust carrying case including all attachments 

On/off button (1) 
Sensor lead port (2) 
USB port (3) 
LED display showing 3 different colours: (4) 

Green = Device is on
Orange = Device is on and charging 
Red = Device is off and charging 

Standard Kit Items: 
Included in the MSPro14 package which is supplied in a robust lightweight case including: 
 Data Acquisition Unit (the measuring box) 
 USB stick containing this manual and latest PC software (DASPro14 - Data Analysis Software) 

Sensor
 Protective Sensor sleeve and sensor spacer set 
 USB cable 
 AC power adaptor 
 External Battery 
 G (or C)-Clamp 

Flashlight & pen

12 3 4 
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RECOMMENDATIONS

Read this manual prior to installing the software and using the device for the first time. All instructions 
included in the manual must be followed. 

Remove any loose dirt/debris from the collector surface prior to taking a profile and always ensure that the 
sensor head is clean before taking any readings as this could affect the results of the profile severely. Use a 
clean, lint free cloth for this, for example, spectacle lens cleaning cloths 

The sensor head is a highly accurate piece of equipment, and although constructed to withstand normal 
handling, it should be treated with care at all times. The sensor should always be stored in its supplied 
sleeve when not in use.

When recording a profile, the results will be more consistent when the sensor is mounted as radially as 
possible (ideally ±1°) and when rotated in the direction as indicated in the figure below. 

Under no circumstances should the sensor be clamped directly – it should always be fitted in a holder or 
sleeve and the sleeve held in place with a clamp. 

It is recommended that the sensor is calibrated every 12 months – this can either be done by sending your 
MSPro14 to your local Morgan Sales office or directly to Morgan Advanced Materials Netherlands. 

Lesen Sie diese Bedienungsanleitung sorgfältig durch, bevor Sie die Software installieren und das Gerät 
zum ersten Mal verwenden. Alle Anweisungen in der Bedienungsanleitung müssen befolgt werden.

Entfernen Sie losen Schmutz/Ablagerungen von der Kollektoroberfläche, bevor Sie die Profilmessung 
durchführen, und vergewissern Sie sich stets, dass der Sensorkopf sauber ist, bevor Sie Messungen 
durchführen, da ein verschmutzter Sensorkopf die Ergebnisse der Profilmessung stark verfälschen kann. 
Verwenden Sie eine sauberes, fusselfreies Tuch wie zum Beispiel ein Brillentuch.

Der Sensorkopf ist ein Präzisionsteil, und auch wenn der Sensorkopf so konstruiert ist, dass er einer 
normalen Handhabung standhält, sollte er stets vorsichtig behandelt werden. Wann immer der Sensor nicht 
verwendet wird, sollte er in der mitgelieferten Hülle aufbewahrt werden.

Bei der Aufzeichnung des Profils erhalten Sie konsistentere Ergebnisse, wenn Sie den Sensor möglichst 
radial montieren (idealerweise ±1°) und in die Richtung gedreht, die in der nachfolgenden Abbildung zu 
sehen ist.

Der Sensor darf auf keinen Fall direkt festgeklemmt werden – er muss sich immer in einer Halterung oder 
Hülle befinden, und die Hülle kann dann mit einer Klemme festgeklemmt werden.

Es ist empfehlenswert, den Sensor alle 12 Monate zu kalibrieren – entweder schicken Sie den MSPro14 
zu diesem Zweck an Ihre örtliche Verkaufsniederlassung von Morgan oder direkt zu Morgan Advanced 
Materials in den Niederlanden.

EMPFEHLUNGEN
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FIRST TIME USE 

Minimum PC requirements:
 Operating system: Windows XP or higher 
 Minimal 100MB of free disk space 
 Minimum of 1GB RAM memory 
 One free USB 2.0 port  

Once connected to a PC using the USB-cable, the Measuring Box reports itself as new USB-device. The 
Measuring Box may be accessed using a Windows File Explorer standard program. This enables the user to: 

Access files stored in the Flash memory of the Measuring Box (note that each measurement results in 
one file) 
update the Measuring Box software
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Registration of software on 1st use
Insert the supplied USB Memory stick into the PC and open the file; double-click on the software link which 
looks like:

Follow the on-screen instructions; if there are any warnings displayed regarding the software installation 
which could depend on your PC configuration, then press ì Yesî , however, if in doubt always contact your IT 
administrator. 

Press ì I agreeî  to continue 

INBETRIEBNAHME

Mindestanforderungen an den PC:

• Betriebssystem: Windows XP oder höher
• Mindestens 100 MB freier Speicherplatz
• Mindestens 1 GB RAM-Speicher
• Freier USB 2.0 Anschluss

Nachdem das Gerät über ein USB-Kabel am PC angeschlossen wurde, erscheint die Messbox als 
neues USB-Gerät. Mit einem Windows File Explorer Standardprogramm kann auf den Messkasten 
zugegriffen werden. Nun hat der Anwender folgende Möglichkeiten:

• �Zugriff auf Dateien, die im Flash-Speicher der Messbox gespeichert sind (beachten Sie, dass jede 
Messung eine Datei ergibt) 

• Aktualisierung der Messbox-Software
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Minimum PC requirements:
 Operating system: Windows XP or higher 
 Minimal 100MB of free disk space 
 Minimum of 1GB RAM memory 
 One free USB 2.0 port  

Once connected to a PC using the USB-cable, the Measuring Box reports itself as new USB-device. The 
Measuring Box may be accessed using a Windows File Explorer standard program. This enables the user to: 

Access files stored in the Flash memory of the Measuring Box (note that each measurement results in 
one file) 
update the Measuring Box software

6

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 6 

Registration of software on 1st use
Insert the supplied USB Memory stick into the PC and open the file; double-click on the software link which 
looks like:

Follow the on-screen instructions; if there are any warnings displayed regarding the software installation 
which could depend on your PC configuration, then press ì Yesî , however, if in doubt always contact your IT 
administrator. 

Press ì I agreeî  to continue 

Software-Registrierung bei der ersten Anwendung

Stecken Sie den mitgelieferten USB-Speicherstick in den PC und öffnen Sie die Datei; machen Sie nun 
einen Doppelklick auf den Software-Link, der folgendermaßen aussieht:

Führen Sie die Bildschirmanweisungen aus. Sollten Warnungen bezüglich der Software-Installation 
angezeigt werden, die möglicherweise aufgrund Ihrer PC-Konfiguration erscheinen, drücken Sie “Ja”. 
Wenn Sie jedoch Zweifel haben, wenden Sie sich an Ihren IT-Administrator.

Um fortzufahren, drücken Sie auf “Ich stimme zu”.
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Click Next 

The default file location is selected; however, change if you require and click ì Nextî  to continue
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Once details are correct, press ì Installî

Once installation is complete, press ì Nextî

Klicken Sie auf “Weiter”.

Es wird der vorgegebene Dateispeicherort ausgewählt; bei Bedarf ändern und auf
“Weiter” drücken, um fortzufahren.
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Once details are correct, press ì Installî

Once installation is complete, press ì Nextî

Sobald alle Angaben korrekt sind, drücken Sie auf “Installieren”.

Sobald die Installation abgeschlossen ist, drücken Sie auf “Weiter”.
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The DASPro14 software is now ready to be registered prior to first use and can be done as follows:  

Double-click the link shown below which should be on your PC desktop: 

This will then open the following screen: 

If a registration key is already known, enter it in the appropriate field, else click the link which opens a 
webpage: 
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http://www.morganelectricalmaterials.com/mspro14-registration-form 

Once the necessary fields have been completed the submit button should be pressed and this will 
automatically send an email to: MSPro14.register@morganplc.com so that a registration key can be sent 
back to the user.

Once the registration key is received enter it in the appropriate field and press ì OKî  and the software will 
open accordingly. 

Die DASPro14-Software kann nun vor der erstmaligen Anwendung registriert werden, und zwar wie folgt:

Es erscheint das folgende Fenster:

Wenn Sie Ihren Registrierungsschlüssel bereits wissen, geben Sie ihn in das entsprechende Feld ein. 
Ansonsten klicken Sie auf den Link, der folgende Webseite öffnet:

Öffnen Sie den nachfolgend gezeigten Link, der sich auf Ihrem PC-Desktop befinden sollte, mit einem Doppelklick.
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The DASPro14 software is now ready to be registered prior to first use and can be done as follows:  

Double-click the link shown below which should be on your PC desktop: 

This will then open the following screen: 

If a registration key is already known, enter it in the appropriate field, else click the link which opens a 
webpage: 
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http://www.morganelectricalmaterials.com/mspro14-registration-form 

Once the necessary fields have been completed the submit button should be pressed and this will 
automatically send an email to: MSPro14.register@morganplc.com so that a registration key can be sent 
back to the user.

Once the registration key is received enter it in the appropriate field and press ì OKî  and the software will 
open accordingly. 

http://www.morganelectricalmaterials.com/mspro14-registration-form

Drücken Sie auf die Schaltfläche Senden, sobald Sie alle erforderlichen Felder ausgefüllt haben. 
Es wird automatisch eine E-Mail an: MSPro14.register@morganplc.com versendet, und ein 
Registrierungsschlüssel wird an den Anwender zurückgesendet.

Geben Sie den Registrierungsschlüssel nun in das entsprechende Feld ein und drücken Sie auf “OK”. Die 
Software öffnet sich daraufhin.
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Software update procedure
Software updating will not be done automatically. The procedure for doing this on both PC-software and 
MSPro14 Box is as follows: 
 The user will receive an attachment in an email sent to the address used for registering the PC software 

or is instructed to download it from a specific server. 
Measuring Box:

ñ  Connect the measuring box to the PC or Laptop. 
ñ  Copy the update file to a specific folder on the measuring box. 
ñ  Disconnect the box from the PC or Laptop. 
ñ  Restart the box to perform the update. 

 PC software 
ñ Follow on-screen instructions as in the initial installation  
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USING THE MSPRO14 MEASURING BOX

First, connect the sensor to the MSPro14 measuring box then turn the unit on; wait for it to start-up at which 
point you will see the following screen: 

Software-Update

Die Software wird nicht automatisch aktualisiert. Ein Software-Update sowohl für die PC Software als auch 
für die MSPro 14 Box kann wie folgt durchgeführt werden:

• �Der Anwender erhält eine E-Mail mit Anhang, die an die Adresse gesendet wird, die für die Registrierung 
der PC-Software verwendet wurde, oder er erhält eine Anweisung, dass er das Update von einem 
speziellen Server herunterladen muss.

• Messkasten:
		  – Schließen Sie die Messbox an den PC oder Laptop an.
		  – Kopieren Sie die Update-Datei in einen speziellen Ordner der Messbox.
		  – Trennen Sie die Messbox vom PC oder Laptop.
		  – Starten Sie die Messbox neu, um das Update durchzuführen.
• PC-Software
		  – Folgen Sie den Bildschirmanweisungen wie bei der Erstinstallation.
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USING THE MSPRO14 MEASURING BOX

First, connect the sensor to the MSPro14 measuring box then turn the unit on; wait for it to start-up at which 
point you will see the following screen: 

Schließen Sie den Sensor zunächst an der MSPro14 Messbox an und schalten Sie das Gerät dann ein. 
Warten Sie, bis es hochgefahren ist. Es erscheint der folgende Bildschirm:

Der Fortschrittsbalken zeigt den Fortschritt des Uploads an. Sobald das Upload beendet ist, erscheint die 
Startseite.

 INBETRIEBNAHME DER MSPRo14 MESSBOX
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Welcome Screen 

This screen shows both the MSPro14 product ID and box software version. 

The symbols on the top of the screen mean the following: 

The size of the memory will be at least 30 Mbyte. This should be enough to store at least 250
datasets. 

Sensor position

Units currently set on box ñ  either metric or imperial 

Battery life

Press ok to continue 

Help 
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Home Screen 

There are 4 options to use: 

Start Measurement

View Data 

Settings 

Help 

Startseite

Auf der Startseite wird sowohl die Produkt-ID von MSPro14 als auch die Messbox - Softwareversion 
angezeigt. 

Die Symbole oben auf dem Bildschirm haben folgende Bedeutung:

Die Speicherkapazität beträgt mindestens 30 MByte. Das sollte für das Speichern von 
mindestens 250 Datensätzen ausreichen.

Sensorposition

Aktuell in der Messbox eingestellte Einheit – entweder metrisch oder britisch

Batterieladung

Um fortzufahren, drücken Sie auf “OK”.

Hilfe
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Home Screen 

There are 4 options to use: 

Start Measurement

View Data 

Settings 

Help 

Hauptseite

Es gibt 4 Optionen auf der Hauptseite:

Messung starten

Daten ansehen

Einstellungen

Hilfe
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SETTINGS 

From this screen you can alter 6-off different settings: 

Date & Time 
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Units & Language 

There are 5 different languages to choose from: English, Dutch, French, German and Spanish

Alarms 

Alarms can be set depending on the tolerances you require 

EINSTELLUNGEN

Auf dieser Seite können Sie zwischen 6 verschiedenen Einstellungen wählen:

Datum & Uhrzeit
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Units & Language 

There are 5 different languages to choose from: English, Dutch, French, German and Spanish

Alarms 

Alarms can be set depending on the tolerances you require 

Einheiten & Sprache

Sie können aus 5 verschiedenen Sprachen auswählen: Englisch, Niederländisch, Französisch, Deutsch 
und Spanisch

Warnmeldungen/-signale

Die Warnmeldungen und Warnsignale können je nach den von Ihnen benötigten Toleranzen eingestellt 
werden.



17

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 17

Display 

Brightness can be automatic or user defined 

Power Management 
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Sensor Settings 

This will display when the sensor number is correct  

If the sensor number is not valid or entered then this is shown 

Display

Die Helligkeit kann entweder automatisch oder benutzerdefiniert eingestellt werden.

Energie-Management
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Sensor Settings 

This will display when the sensor number is correct  

If the sensor number is not valid or entered then this is shown 

Sensoreinstellungen

Das wird angezeigt, wenn die Sensornummer korrekt ist.

Das wird angezeigt, wenn die Sensornummer ungültig ist oder nicht eingegeben wurde.
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START MEASUREMENT 

Once you decide to take a measurement you must determine the type of collector on which the profile is 
being taken, i.e. Commutator or Slip-ring

Commutator 
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On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the number of bars is known (diameter can also be entered but is not as accurate on a commutator)
then this should be entered as it will mean that the recording will stop automatically rather than the user 
having to stop the recording manually. 

Enter the required information using the on-screen keypad. Note the highlighted ë 0í ; if there are any 
machines in your database this number will reflect that allowing you to choose the previously entered 
machines ñ thus saving re-entering information.

The next screen is used to determine whether you require TIR and MBTB alarms, and if so, the value at 
which it is triggered; note that the default is that which is set on the Alarms page previously described. 

MESSUNG STARTEN

Sobald Sie eine Messung machen möchten, müssen Sie den Kollektortyp bestimmen, auf dem die
Profilmessung gemacht werden soll, d.h. Kommutator oder Schleifring.

Kommutator
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On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the number of bars is known (diameter can also be entered but is not as accurate on a commutator)
then this should be entered as it will mean that the recording will stop automatically rather than the user 
having to stop the recording manually. 

Enter the required information using the on-screen keypad. Note the highlighted ë 0í ; if there are any 
machines in your database this number will reflect that allowing you to choose the previously entered 
machines ñ thus saving re-entering information.

The next screen is used to determine whether you require TIR and MBTB alarms, and if so, the value at 
which it is triggered; note that the default is that which is set on the Alarms page previously described. 

Hier müssen möglichst viele Angaben gemacht werden, da dieser Bildschirm zum Erstellen Ihrer eigenen 
firmenspezifischen Maschinendatenbank verwendet werden kann. Damit eine Maschine in der Datenbank 
erfasst werden kann, müssen die oberen Felder ausgefüllt werden:

• Maschinenbezeichnung

• Hersteller

• Modell

Falls die Anzahl der Lamellen bekannt ist, sollte diese auch eingegeben werden (es kann auch der 
Durchmesser eingegeben werden; dieser ist bei Kommutatoren allerdings nicht so genau). Dadurch wird 
die Aufzeichnung automatisch beendet und muss nicht durch Anwender manuell beendet werden.

Geben Sie die erforderlichen Angaben über die Bildschirmtastatur ein. Beachten Sie die hervorgehobene 
‘0’. Wenn Sie Maschinen Datenbank erfasst haben, zeigt diese Nummer an, dass Sie aus den bereits 
eingegebenen Maschinen auswählen können – Sie müssen die Angaben nicht nochmal eingeben.

Auf dem nächsten Bildschirm können Sie festlegen, ob Sie einen Alarm für TIR und MBTB benötigen, und 
falls ja, bei welchem Wert Alarm ausgelöst werden soll. Beachten Sie, dass die Standardeinstellung der 
Einstellung entspricht, die auf der bereits erläuterten
Alarm-Seite vorgenommen wurde.
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Setting the Sensor 
The sensor has been designed so that for the greatest measurement range the sensor head should be
positioned mid-way through its travel, i.e. 3mm (118mil) in real terms, out of a possible 6mm (236mil). The 
ideal displacement is 0.00mm (0mil) however anywhere between ±0.2mm (±8mil) can be used as a start 
point. In order to fit the sensor the following needs to done: 
 Loosen the clamp knob counter-clockwise so that the clamp is as flat as possible. 
 Fit the sensor into the chosen empty brush box or sleeve along with any required packing pieces (or 

custom made holder) but do not tighten fully at this stage. Care should be taken to ensure that the sensor 
is fitted as square as possible in the brush box and if a commutator is being profiled (ideally) in the centre 
of a bar not in the gap between bars. 

 The sensor must be located in the brush box so the display reads ±0.2mm or ±8 mil or less; this will be 
highlighted by the screen displaying either red, amber or green icons – with appropriate text 
accompanying the icon: 
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Sensor einstellen
Der Sensor ist so konstruiert, dass der Sensorkopf in der Mitte seines Verfahrwegs positioniert werden 
muss, um einen größtmöglichen Messbereich zu erhalten, d.h. effektiv 3 mm (118 mil) von möglichen 6 
mm ( 236 mil). Der ideale Versatz ist 0,00 mm (0 mil). Allerdings jeder Wert zwischen ± 0,2 mm (± 8 mil) als 
Anfangspunkt verwendet werden. Folgende Schritte müssen durchgeführt werden, Sensor zu befestigen:

• Lösen Sie den Klemmenknopf entgegen dem Uhrzeigersinn, so dass die Klemme möglichst flach ist.

• �Setzen Sie den Sensor zusammen mit den erforderlichen Packstücken (oder der kundenspezifischen 
Halterung) in den ausgewählten leeren Bürstenkasten oder die Hülle ein. Ziehen Sie ihn aber noch nicht 
fest. Bitte achten Sie darauf, dass der Sensor möglichst in den Bürstenkasten eingefügt wird, und falls die 
Messung an einem Kommutator durchgeführt wird, idealerweise in der Mitte und nicht im Spalt zwischen 
den Lamellen.

• �Der Sensor muss so im Bürstenkasten positioniert werden, dass auf dem Display ± 0,2 mm oder ± 8 mil 
oder weniger angezeigt Das wird auf dem Bildschirm durch rote, gelbe oder grüne Symbole angezeigt.
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Setting the Sensor 
The sensor has been designed so that for the greatest measurement range the sensor head should be
positioned mid-way through its travel, i.e. 3mm (118mil) in real terms, out of a possible 6mm (236mil). The 
ideal displacement is 0.00mm (0mil) however anywhere between ±0.2mm (±8mil) can be used as a start 
point. In order to fit the sensor the following needs to done: 
 Loosen the clamp knob counter-clockwise so that the clamp is as flat as possible. 
 Fit the sensor into the chosen empty brush box or sleeve along with any required packing pieces (or 

custom made holder) but do not tighten fully at this stage. Care should be taken to ensure that the sensor 
is fitted as square as possible in the brush box and if a commutator is being profiled (ideally) in the centre 
of a bar not in the gap between bars. 

 The sensor must be located in the brush box so the display reads ±0.2mm or ±8 mil or less; this will be 
highlighted by the screen displaying either red, amber or green icons – with appropriate text 
accompanying the icon: 
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 When the sensor head is in position (ideally the display will be green), tighten the clamp in the holder or 
sleeve fully so that there is no movement from the sensor. Only hand tighten the sensor and do not use 
any tools or other equipment (as over tightening may damage the clamp). 

 Mark the collector surface so that a reference start/stop point can be located 
 Next, the collector needs to be rotated in the direction in which the profile will be taken in order to stabilise 

the sensor; if a full rotation is not possible then the collector must be rocked back and forth slightly – note 
that for consistent results the last movement must be in the same direction as that in which the profile will 
be taken. Note that the ‘Operational’ and ‘Settled’ �ags (on bottom left hand side of the screen) will 
change to ‘OK’ once this has been carried out correctly.

 Check the display still reads ±0.2mm (±8mil) or less and if you are measuring a commutator also ensure 
that the sensor is still located approximately in the middle of the marked bar 

 It is possible to continue when the sensor has not been placed correctly, i.e. when the arrow is orange
however an additional warning appears advising you of the issue. 
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Completing one Recording 

The collector should be rotated and the unit will start taking recordings 

• �Sobald der Sensorkopf positioniert ist (im Idealfall ist das Display grün), können Sie die Klemme in der 
Halterung oder der Hülle ganz festziehen, so dass sich der Sensor nicht mehr bewegt. Ziehen Sie den 
Sensor nur handfest an und verwenden Sie kein Werkzeug oder andere Tools (durch ein Überziehen 
kann die Klemme beschädigt werden).

• �Markieren Sie die Kollektoroberfläche, so dass ein Referenzpunkt zum Starten/Stoppen lokalisiert werden 
kann.

• �Als nächstes muss der Kollektor in die Richtung gedreht werden, in der die Profilmessung durchgeführt 
wird, um so den Sensor zu stabilisieren. Wenn eine ganze Umdrehung nicht möglich ist, muss der 
Kollektor vorsichtig vor und zurück geschoben werden. Bitte beachten Sie: Um konkrete Ergebnisse 
zu erhalten, muss die letzte Bewegung in die Richtung erfolgen, in die die Profilmessung gemacht wird. 
Sobald dies korrekt ausgeführt wurde, schalten die Flags ‘Betrieb’ und ‘Justiert’ (unten links auf dem 
Bildschirm) auf ‘OK’.

• �Überprüfen Sie, ob auf dem Display weiterhin ± 0,2 mm (± 8 mil) oder weniger angezeigt wird. Falls Sie 
einen Kommutator messen, müssen Sie sich außerdem vergewissern, dass sich der Sensor weiterhin 
etwa in der Mitte der markierten Lamelle befindet.

• �Die Messung kann auch dann fortgesetzt, werden, wenn der Sensor nicht richtig platziert wurde, d.h. 
wenn der Pfeil orange ist. Es erscheint jedoch eine weitere Warnmeldung, die auf das Problem hinweist.
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 When the sensor head is in position (ideally the display will be green), tighten the clamp in the holder or 
sleeve fully so that there is no movement from the sensor. Only hand tighten the sensor and do not use 
any tools or other equipment (as over tightening may damage the clamp). 

 Mark the collector surface so that a reference start/stop point can be located 
 Next, the collector needs to be rotated in the direction in which the profile will be taken in order to stabilise 

the sensor; if a full rotation is not possible then the collector must be rocked back and forth slightly – note 
that for consistent results the last movement must be in the same direction as that in which the profile will 
be taken. Note that the ‘Operational’ and ‘Settled’ �ags (on bottom left hand side of the screen) will 
change to ‘OK’ once this has been carried out correctly.

 Check the display still reads ±0.2mm (±8mil) or less and if you are measuring a commutator also ensure 
that the sensor is still located approximately in the middle of the marked bar 

 It is possible to continue when the sensor has not been placed correctly, i.e. when the arrow is orange
however an additional warning appears advising you of the issue. 
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Completing one Recording 

The collectornunnshould be rotated and the unit will start taking recordings 

Aufzeichnung fertigstellen

Der Kollektor nun drehen und das Gerät beginnt mit den Aufzeichnungen.
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When rotation is detected the  will change to ; the recording will stop automatically if 

the number of bars (or diameter) was entered, else  will have to be pressed. 

It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between text or a real-time linear graph. 
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On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Return to home screen without saving 

Re-take recording, therefore deleting existing one 

Wenn eine Drehung festgestellt wurde, wechselt der  auf  ; die Aufzeichnung 
wird automatisch beendet, wenn die Anzahl der Lamellen (oder der Durchmesser) eingegeben wurde; 

 ansonsten gedrückt werden.

Sie können die Art, wie die Messungen angezeigt werden, ändern, indem Sie die Schaltfläche  

oder  drücken; dadurch wechseln Sie zwischen Text oder linearer Echtzeitgrafik.
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When rotation is detected the  will change to ; the recording will stop automatically if 

the number of bars (or diameter) was entered, else  will have to be pressed. 

It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between text or a real-time linear graph. 
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On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Return to home screen without saving 

Re-take recording, therefore deleting existing one 

Sobald die Aufzeichnung beendet ist, wird folgende Zusammenfassung angezeigt:

Die Symbole unten auf dem Bildschirm haben folgende Bedeutung:

Zurück zur Hauptseite ohne Speichern

Aufzeichnung nochmals durchführen und daher bestehende 
Aufzeichnung löschen
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View alarms/errors ñ if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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If the user wants to save the recording, the following screen is displayed: 

The default filename is in the format: year/month/day-hour/minute/second – hence it will be totally unique; 
this filename can be over-written and/or modified if desired. 

In order to add the machine details into the database, the  button must be pressed – provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Ist der Rand dieses Symbol rot statt grau, dann kann man Alarme/Fehler ansehen. 

Wenn dieses Symbol rot leuchtet, müssen Sie sich die Radialgrafik ansehen.

Aufzeichnung speichern

Bei ausgelösten Alarmmeldungen / Fehlern erscheint die folgende Anzeige:

Mit der Schaltfläche für die Radialgrafik erhält der Anwender eine Übersicht über die allgemeine Form – und 
kann größer und

fvzelm
Getypte tekst
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View alarms/errors ñ if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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If the user wants to save the recording, the following screen is displayed: 

The default filename is in the format: year/month/day-hour/minute/second – hence it will be totally unique; 
this filename can be over-written and/or modified if desired. 

In order to add the machine details into the database, the  button must be pressed – provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Wenn der Anwender die Aufzeichnung speichern möchte, wird der folgende Bildschirm angezeigt:

Der Standarddateiname hat das Format Jahr/Monat/Tag-Stunde/Minute/Sekunde und ist somit eindeutig. dieser 
Dateiname kann nach Wunsch überschrieben und/oder geändert werden.

Zum Hinzufügen von Angaben zur Maschine in der Datenbank muss die  Schaltfläche gedrückt 
werden – vorausgesetzt, dass diese Angaben nicht bereits in der Datenbank sind; es sei denn, der Anwender 
möchte die bestehenden Daten durch die neueste(n) Messung(en) aktualisieren.
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The information can be transferred into the database by pressing the  button. 

Once the user wants to save the recording, the  button must be pressed. This will then lead to 
the following options: 
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Same Machine returns the user to the sensor 
setup 

Different Machine returns the user to the Start 
Measurement screen 

Return to home screen 

Die Angaben können in die Datenbank übertragen werden, indem man die Schaltfläche  drückt.

Wenn der Anwender die Aufzeichnung speichern möchte, muss die Schaltfläche  gedrückt 
werden. Es erscheinen folgende Optionen:
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The information can be transferred into the database by pressing the  button. 

Once the user wants to save the recording, the  button must be pressed. This will then lead to 
the following options: 
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Same Machine returns the user to the sensor 
setup 

Different Machine returns the user to the Start 
Measurement screen 

Return to home screen 

Dieselbe Maschine bringt den Anwender wieder zurück auf die Sensoreinstellung.

Eine andere Maschine bringt den Anwender auf den Bildschirm ‘Messung starten’.

Zurück zum Hauptbildschirm
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ing 

On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the diameter is known then this should be entered as it will mean that the recording will stop 
automatically rather than the user having to stop the recording manually. Sc
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The next screen is used to determine whether you require TIR and Low Point alarms, and if so, the value at 
which it is triggered; note that the default is that which is set in the Alarms page. 

Setting the Sensor 
Set the Sensor in the same way as that described for a Commutator. 

Schleifring

Hier müssen möglichst viele Angaben gemacht werden, da dieser Bildschirm zum Erstellen Ihrer eigenen 
firmenspezifischen Maschinendatenbank verwendet werden kann. Damit eine Maschine in der Datenbank 
erfasst werden kann, müssen die oberen 3 Felder ausgefüllt werden:

• Maschinenbezeichnung

• Hersteller

• Modell

Falls der Durchmesser bekannt ist, sollte dieser eingegeben werden. Dadurch wird die Aufzeichnung 
automatisch beendet und muss nicht durch den Anwender manuell beendet werden.
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Slip-ring 

On this screen as much information as possible is to be filled in as it can be used to generate your own 
company specific machine database, and in order for a machine to be saved in the database the top 3 fields 
are to be completed: 
 Machine Name 
 Manufacturer 
 Model 

Also, if the diameter is known then this should be entered as it will mean that the recording will stop 
automatically rather than the user having to stop the recording manually. 
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The next screen is used to determine whether you require TIR and Low Point alarms, and if so, the value at 
which it is triggered; note that the default is that which is set in the Alarms page. 

Setting the Sensor 
Set the Sensor in the same way as that described for a Commutator. 

Auf dem nächsten Bildschirm können Sie festlegen, ob Sie einen Alarm für TIR und Tiefpunkte benötigen, 
und falls ja, bei welchemWert der Alarm ausgelöst werden soll. Beachten Sie, dass die Standardeinstellung 
der Einstellung entspricht, die auf der Alarm-Seite vorgenommen wurde.

Sensor einstellen
Der Sensor wird genauso eingestellt, wie beim Kommutator.
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Completing one Recording

e collector should be rotated and the unit will start taking recordings 

When rotation is detected the  will change to ; the recording will stop automatically if 

the diameter was entered, else  will have to be pressed. 
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It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between either text or a real-time graph. 

On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Aufzeichnung fertigstellen

Den Schleifring nun drehen und das Gerät beginnt mit den Aufzeichnungen.

Wenn eine Drehung festgestellt wurde, wechselt der  auf  ; die Aufzeichnung wird 
automatisch beendet, wenn der Durchmesser eingegeben wurde; ansonsten muss die Schaltfläche 

 gedrückt werden.
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Completing one Recording 

The collector should be rotated and the unit will start taking recordings 

When rotation is detected the  will change to ; the recording will stop automatically if 

the diameter was entered, else  will have to be pressed. 
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It is possible to alter the way the readings are displayed by pressing the  or  button; 
this will alternate between either text or a real-time graph. 

On completion of the recording, the following summary page is displayed: 

The symbols on the bottom of the screen mean the following: 

Sie können die Art, wie die Messungen angezeigt werden, ändern, indem Sie die Schaltfläche  

oder  drücken; dadurch wechseln Sie zwischen Text oder Echtzeitgrafik.

Sobald die Aufzeichnung beendet ist, wird folgende Zusammenfassung angezeigt:

Die Symbole unten auf dem Bildschirm haben folgende Bedeutung:
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out saving 

Re-take recording 

View alarms/errors ñ  if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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The results can be saved in exactly the same way as that described in the Commutator section. 

In order to add the machine details into the database, the  button must be pressed ñ  provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Zurück zur Hauptseite ohne speichern

Aufzeichnung nochmal durchführen

Alarme/Fehler ansehen  

Wenn dieses Symbol rot leuchtet, müssen Sie sich die Radialgrafik ansehen

Aufzeichnung speichern

Bei ausgelösten Alarmmeldungen / Fehlern erscheint die folgende Anzeige:

Mit der Schaltfläche für die Radialgrafik erhält der Anwender eine Übersicht über die allgemeine Form
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Return to home screen without saving 

Re-take recording 

View alarms/errors ñ  if this symbol is highlighted in red 

View radial plot

Save recording 

If there are any alarms triggered/errors they will be displayed as follows: 

The radial plot button allows the user to have an overview of the general shape ñ  and zoom in and out. 
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The results can be saved in exactly the same way as that described in the Commutator section. 

In order to add the machine details into the database, the  button must be pressed ñ  provided 
the machine information is not already in the database, unless the user wants to update the existing data 
with the latest reading(s). 

Die Ergebnisse können genauso gespeichert werden, wie das bereits im Kapitel Kommutator beschrieben 
wurde.

Zum Hinzufügen von Angaben zur Maschine in der Datenbank muss die Schaltfläche 
gedrückt werden – vorausgesetzt, dass diese Angaben nicht bereits in der Datenbank sind; es sei denn, 
der Anwender möchte die bestehenden Daten durch die neueste(n) Messung(en) aktualisieren.
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The information can be transferred into the database by pressing the  button and saved as 
previously described.
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VIEW DATA 

When the user wants to view previously taken collector readings, the following screen will be displayed: 

Scrolling through the data sets can be achieved by using the arrows on the side of the screen. 

When the required data set is located, the  button should be pressed. This will then show the 
individual recordings taken for on each machine:

Die Angaben können in die Datenbank übertragen werden, indem man die Schaltfläche  drückt 
und wie zuvor beschrieben speichert.
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The information can be transferred into the database by pressing the  button and saved as 
previously described.
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VIEW DATA 

When the user wants to view previously taken collector readings, the following screen will be displayed: 

Scrolling through the data sets can be achieved by using the arrows on the side of the screen. 

When the required data set is located, the  button should be pressed. This will then show the 
individual recordings taken for on each machine:

DATEN ANSEHEN

Wenn der Anwender bereits durchgeführte Kollektormessungen ansehen möchte, erscheint der folgende 
Bildschirm:

Mit den Pfeilen an der Seite des Bildschirms kann man durch die Datensätze scrollen.

Sobald der erforderliche Datensatz gefunden wurde, muss die Schaltfläche  gedrückt werden. 
Es werden die einzelnen Aufzeichnungen angezeigt, die für jede Maschine gemacht wurden:
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Once the required recording is located the  button is again pressed to continue; this will then 
display the same screen as that displayed following the completion of the recording, i.e.: 

The different icons can be selected as previously described.
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Standby Screen

On the main menu, the  button gives the user the following options: 

Turns the screen off 

Turns the unit off 

Returns to home screen 

After pressing the ì Display Offî  button the screen will go blank/turn off; when the screen is then pressed 
again the following is shown: 

Sobald die erforderliche Aufzeichnung gefunden wurde, muss die Schaltfläche 
nochmals gedrückt werden, um fortzufahren. Es erscheint der Bildschirm, der nach
Fertigstellung der Aufzeichnung angezeigt wurde, i.e.:

die verschiedenen Symbole können wie bereits beschrieben ausgewählt werden.
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Once the required recording is located the  button is again pressed to continue; this will then 
display the same screen as that displayed following the completion of the recording, i.e.: 

The different icons can be selected as previously described.
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Standby Screen

On the main menu, the  button gives the user the following options: 

Turns the screen off 

Turns the unit off 

Returns to home screen 

After pressing the ì Display Offî  button the screen will go blank/turn off; when the screen is then pressed 
again the following is shown: 

Bereitschaftsbildschirm

Im Hauptmenü erhält der Anwender über die Schaltfläche  folgende Optionen:

Schaltet den Bildschirm aus 

Schaltet das Gerät aus 

Zurück zur Hauptseite

Nachdem Sie die Schaltfläche “Display ausschalten” gedrückt haben, wird der Bildschirm schwarz/schaltet 
sich ab. Wenn Sie dann wieder auf den Bildschirm drücken, erscheint folgende Ansicht:



41

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 41

Pressing the screen again takes you back to the Home screen 

The Power Off button shows the following screen: 

Return to home screen without turning off 

Turns unit off 
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Durch erneutes Drücken auf den Bildschirm kommen Sie wieder zur Hauptseite zurück. Durch Drücken der 
Schaltfläche

“Ausschalten” erscheint der folgende Bildschirm:

Zurück zur Hauptseite ohne Ausschalten 

Gerät wird ausgeschaltet
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Pressing the screen again takes you back to the Home screen 

The Power Off button shows the following screen: 

Return to home screen without turning off 

Turns unit off 
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PC ANALYSIS SOFTWARE 

DASPro14 
To open the DASPro14 software double-click the link as shown below: 

GENERAL 

 The DASPro14 can be run on a PC or Laptop running Windows® XP or higher. 
 Multiple Measuring Boxes can be managed by a single PC or Laptop. 

Only one Measuring Box can be connected to the PC or Laptop at the same time. There will be no support for 
handling multiple Measuring Boxes simultaneously. 

 No licence is needed to run the DASPro14 software. 
 Capability to import measuring files from the old PC profiler software 
 Prepare a measurement on PC
 Download it to the measuring box

USER INTERFACE 

The main window contains the following areas: 
 (1) Selected Downloaded datasets 
 (2) Recordings list: Selected recordings from the downloaded datasets. 
 (3) View area: this area will be used to plot the recordings, show values, etc. and has multiple tabs: 

1

2 

3
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 Tab bar:
1. Info: The info tabshows information about the loaded measurement and allows the user to make changes: 

a) User details (eg. Company, Operator, etc) 
b) Alarm Settings: BTB, TIR, etc. 
c) Recording details (eg. Name, type, size, etc.)

2. Values: This tab will show a table containing the measured values in numeric form. The values can be
modified by the user. 

a) Ability to copy values to clipboard for pasting in another application (for example, Microsoft. Excel)

PC-ANALYSE-SOFTWARE

DASPro14

Die DASPro14-Software kann mit einem Doppelklick auf den nachfolgend gezeigten Link geöffnet werden:

ALLGEMEIN

• DASPro14 kann auf einem PC oder Laptop mit Windows® XP oder höher betrieben werden.
• Es können mit einem einzigen PC oder Laptop mehrere Messkästen verwaltet werden.
• �Es kann immer nur ein Messkasten am PC oder Laptop angeschlossen werden. Das Betätigen von 

mehreren Messkästen gleichzeitig unterstützt.
• Zum Betreiben der DASPro14-Software wird keine Lizenz benötigt.
• Importieren von Messdateien aus der alten PC-Profilmesssoftware möglich
• Vorbereitung von Messungen auf dem PC
• Herunterladen der Messungen auf den Messkasten

BENUTZEROBERFLÄCHE

Das Hauptfenster besteht aus den folgenden Bereichen:

• (1) Ausgewählte heruntergeladene Datensätze

• (2) Liste der Aufzeichnungen: Ausgewählte Aufzeichnungen aus den heruntergeladenen 

• (3) �Ansichtsbereich: für diesen Bereich werden die Aufzeichnung geplottet, die Werte an Dgeazteeingstä 
utzsewn. .Der Bereich hat verschiedene Registerkarten:
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PC ANALYSIS SOFTWARE 

DASPro14 
To open the DASPro14 software double-click the link as shown below: 

GENERAL 

 The DASPro14 can be run on a PC or Laptop running Windows® XP or higher. 
 Multiple Measuring Boxes can be managed by a single PC or Laptop. 

Only one Measuring Box can be connected to the PC or Laptop at the same time. There will be no support for 
handling multiple Measuring Boxes simultaneously. 

 No licence is needed to run the DASPro14 software. 
 Capability to import measuring files from the old PC profiler software 
 Prepare a measurement on PC
 Download it to the measuring box

USER INTERFACE 

The main window contains the following areas: 
 (1) Selected Downloaded datasets 
 (2) Recordings list: Selected recordings from the downloaded datasets. 
 (3) View area: this area will be used to plot the recordings, show values, etc. and has multiple tabs: 

1

2 

3
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 Tab bar:
1. Info: The info tabshows information about the loaded measurement and allows the user to make changes: 

a) User details (eg. Company, Operator, etc) 
b) Alarm Settings: BTB, TIR, etc. 
c) Recording details (eg. Name, type, size, etc.)

2. Values: This tab will show a table containing the measured values in numeric form. The values can be
modified by the user. 

a) Ability to copy values to clipboard for pasting in another application (for example, Microsoft. Excel)

• Registerkartenleiste:
1. �Info: Die Registerkarte Info zeigt Informationen über die geladene Messung. Hier kann der Anwender 

Änderungen machen:

a) Angaben zum Anwender (z.B. Unternehmen, Betreiber usw.)

b) Alarmeinstellungen: BTB, TIR usw.

c) Angaben zur Aufzeichnung (z.B. Name, Typ, Größe usw.)

2.   �Werte: Diese Registerkarte zeigt eine Tabelle mit den Messwerten in numerischer Form. Die Werte 
können durch den Anwender 

a) �Werte in Zwischenablage kopieren, um sie in einer anderen Anwendung einzufügen (zum Beispiel 
Microsoft Excel)
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3. Chart: The chart tab will show a linear plot of the selected recording(s). Available functions are: 

a) Pan & zoom
b) Rotate, flip & align plot
c) Adjust axis scale & colours
d) Show/hide horizontal and/or vertical gridlines 
e) Copy (copy chart plot + legend as a picture on the clipboard) 
f) Print (chart plot + headers) 

4. Radial: The radial tab will show a radial plot of the selected recording(s). Available functions are: 

a) Pan & zoom
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b) Rotate, flip & align plot
c) Adjust axes scale & colours 
d) Show/hide middle circle, limit circles and/or central gridlines
e) Copy radial plot + legend as a picture on the clipboard 
f) Print (radial plot + headers)

Menu bar 
1. File: file related functions like: open, save, close, etc. 
2. Box
3. Tools
4. Help 

 Button bar: The button bar will show the most commonly used functions as buttons. Depending on the 
selected tab, other buttons will be available. 

 Status bar: shows status information and is  used for showing status information, for example: 
1. Detected Measuring Box 
2. PC/Measuring Box software update available (future option) 

USING DASPRO14 FOR THE FIRST TIME 

On first use the import folder in which the datasets will be downloaded to needs to be set; the following 
screen will be displayed: (Note that this can be changed at any time by selecting “Tools>Settings”

The units and language can also be set in this screen

USING DASPRO14 

Adding Datasets 

There are 2 ways in which recordings can be added to the import folder: 
 As in normal file handling and dragging and dropping the associated files directly from the MSPro14 unit 

3. �Tabelle: Die Registerkarte Tabelle zeigt die lineare grafische Darstellung der ausgewählten 
Aufzeichnung(en). Verfügbare

a) Schwenken & Zoomen
b) Grafik drehen & anpassen
c) Größe & Farbe der Achse anpassen
d) Horizontale und/oder vertikale Gitterlinien anzeigen/verbergen
e) Kopieren (Tabellengrafik und Legende als Bild in die Zwischenablage kopieren)
f) Drucken (Tabellengrafik + Überschriften)

4. Radial: Die Registerkarte Radial zeigt die radiale grafische Darstellung der ausgewählten 
Aufzeichnung(en). Verfügbare Funktionen:

a)  Schwenken & Zoomen
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3. Chart: The chart tab will show a linear plot of the selected recording(s). Available functions are: 

a) Pan & zoom
b) Rotate, flip & align plot
c) Adjust axis scale & colours
d) Show/hide horizontal and/or vertical gridlines 
e) Copy (copy chart plot + legend as a picture on the clipboard) 
f) Print (chart plot + headers) 

4. Radial: The radial tab will show a radial plot of the selected recording(s). Available functions are: 

a) Pan & zoom
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b) Rotate, flip & align plot
c) Adjust axes scale & colours 
d) Show/hide middle circle, limit circles and/or central gridlines
e) Copy radial plot + legend as a picture on the clipboard 
f) Print (radial plot + headers)

Menu bar 
1. File: file related functions like: open, save, close, etc. 
2. Box
3. Tools
4. Help 

 Button bar: The button bar will show the most commonly used functions as buttons. Depending on the 
selected tab, other buttons will be available. 

 Status bar: shows status information and is  used for showing status information, for example: 
1. Detected Measuring Box 
2. PC/Measuring Box software update available (future option) 

USING DASPRO14 FOR THE FIRST TIME 

On first use the import folder in which the datasets will be downloaded to needs to be set; the following 
screen will be displayed: (Note that this can be changed at any time by selecting “Tools>Settings”

The units and language can also be set in this screen

USING DASPRO14 

Adding Datasets 

There are 2 ways in which recordings can be added to the import folder: 
 As in normal file handling and dragging and dropping the associated files directly from the MSPro14 unit 

b) Grafik drehen & anpassen

c) Größe & Farbe der Achsen anpassen

d) Mittelzirkel, Grenzzirkel und/oder mittlere Gitterlinien anzeigen/verbergen

e) Radialgrafik und Legende als Bild in die Zwischenablage kopieren

f) Drucken (Radialgrafik + Überschriften)

•    Menüleiste
1. Datei: dateibezogene Funktionen wie Öffnen, Speichern, Schließen usw.
2. Kasten
3. Tools
4. Hilfe

•    �Schaltflächenleiste: Die Schaltflächenleiste zeigt die gängigsten Funktionen als Schaltfläche. Je nach 
ausgewählter Registerkarte sind andere Schaltflächen verfügbar.

•    �Statusleiste: zeigt Informationen zum Status und wird zur Anzeige von Statusinformationen verwendet, 
zum Beispiel:
1. Ermittelter Messkasten
2. Update für PC-/Messkasten-Software verfügbar (künftige Option)

ERSTINBETRIEBNAHME VON DASPro14

Für die Erstinbetriebnahme muss der Import-Ordner, in welchen die Datensätze heruntergeladen werden, 
erstellt werden. Es erscheint der nachfolgende Bildschirm: (Beachten Sie, dass Änderungen jederzeit über 
“Tools>Einstellungen” vorgenommen werden können.)

Auf diesem Bildschirm können außerdem die Einheiten und die Sprache eingestellt werden.

VERWENDUNG VON DASPro14

Datensätze hinzufügen

Es gibt zwei Möglichkeiten, wie man Aufzeichnungen zum Import-Ordner hinzufügen kann:

• �Wie bei herkömmlicher Dateibearbeitung durch Ziehen und Ablegen der betreffenden Dateien direkt aus 
MSPro14.
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By selecting “Download from Measurement Box” and following the on -screen instructions

Once there are datasets on the PC, they can be added by pressing the  button; the dataset will then be 
displayed in the dedicated area. Clicking on the dataset displays the individual recordings: 

Double-clicking on the individual recording will add it to the recordings list where it can be viewed in detail by 
selecting one of the 4 different tabs 
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Printing 

To print a report on the data, click File>Print Report and select what needs to be printed from the 
available options and follow on-screen instructions

• Durch Auswählen von “Von Messbox downloaden” und Folgen der Bildschirmanweisungen.

Sobald sich Datensätze auf dem PC befinden, können sie hinzugefügt werden, indem Sie die Schaltfläche 

 drücken. Der Datensatz wird nun in dem zugeordneten Bereich angezeigt. Durch Klicken auf den 
Datensatz werden die einzelnen Aufzeichnungen angezeigt:

Durch Doppelklick auf eine einzelne Aufzeichnung wird diese der Liste der Aufzeichnungen hinzugefügt. 
Dort kann sie im Detail angesehen werden, indem Sie eine der 4 verschiedenen Registerkarten auswählen.
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By selecting “Download from Measurement Box” and following the on -screen instructions

Once there are datasets on the PC, they can be added by pressing the  button; the dataset will then be 
displayed in the dedicated area. Clicking on the dataset displays the individual recordings: 

Double-clicking on the individual recording will add it to the recordings list where it can be viewed in detail by 
selecting one of the 4 different tabs 
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Printing 

To print a report on the data, click File>Print Report and select what needs to be printed from the 
available options and follow on-screen instructions

Drucken
Zum Ausdrucken eines Datenberichts klicken Sie auf Datei>Bericht drucken und wählen Sie aus den 
verfügbaren Optionen aus, was Sie drucken möchten. Folgen Sie den Bildschirmanweisungen.
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Reading and Comparing Values

 When a chart is displayed it is possible to follow the profile and obtain specific information along the 
length of the profile; this can be done by placing the cross-hair at the required point and clicking the left 
mouse button. Once this is done a horizontal and vertical line will appear, and the values indicated by the 
cross-hair are displayed in the top right-hand corner of the chart 

 Note that the cross-hair can be moved by pressing the left and right arrows on the keyboard 

Adjusting Profiles

There are 6 different buttons available to allow the user to adjust the way in which the profiles are displayed 
and mean that profiles that were taken on the same machines, but from different starting positions, can be
aligned. 

Move the profile left by one bar/segment 

Move the profile right by one bar/segment 

Return the profile to its original position 

Mirroring the profile 

When there are 2 or more profiles this aligns the profile to 
the highest bar/segment 

When there are 2 or more profiles this aligns the profile to 
the lowest bar/segment
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Zooming behaviour 

 Zooming is only possible in the Chart and Radial tabs. To zoom in on any part of a chart: 
1. Left-click a place on the left side of the chart section you wish to zoom. 
2. Hold down the mouse button while you drag a rectangle across and down to the right. 
3. Release the mouse button to perform the zoom. To zoom in horizontally: 
4. Proceed as above, but only move the mouse directly left or right to select the area to be enlarged. Two

vertical lines will be displayed across the chart to indicate the selection. 
Tozoominvertically:
1. Proceed as above, but only move the mouse directly up or down to select the area to be enlarged. Two 

horizontal lines will be displayed across the chart to indicate the selection. 
 To zoom out from any view:

1. Left-click any place in the chart and drag a rectangle across and up to the left to display a rectangle with
a cross in it. When you release the mouse button the chart will return to its original size and location. 

Alarms 

The PC-Software can check the commutator and slip ring recordings for the following alarm conditions. If the 

button is in colour  then it will indicate that an alarm has been triggered on the selected profile, if black 

and white then no alarms are triggered:

 TIR - Total Indicated Runout 
ñ  The difference between the highest and lowest points on the profile. 

MBTB - Maximum Bar-to-bar
ñ  The difference in height between adjacent commutator bars. 

MSTS - Maximum Segment to segment 
ñ  The difference in height between adjacent slip ring segments. 

High Mica
ñ  Lists anyMica insulation (between commutator bars) which are not recessed below the bar

surface. 

Downloading .Mas files

It is possible to download profiles taken on the previous version of the profiler that Morgan used to offer; this 
can be done by selecting ì File>Importing MAS FileÖ î  and following the on-screen instructions. 

Werte lesen und vergleichen

• �Wird eine Tabelle angezeigt, ist es möglich, dem Profil zu folgen und spezifische Informationen entlang 
der Profillänge zuerhalten. Zu diesem Zweck setzt man das Fadenkreuz auf den gewünschten Punkt 
und drückt die linke Maustaste. Daraufhinerscheint eine horizontale und vertikale Linie, und die vom 
Fadenkreuz angezeigten Werte werden oben rechts in der Ecke derTabelle angezeigt.

• �Bitte beachten Sie, dass das Fadenkreuz durch Drücken der linken und rechten Pfeiltasten auf der 
Tastatur bewegt werden kann.

Profile anpassen

Es gibt 6 verschiedene Schaltflächen, über die der Anwender die Ansicht der Profile anpassen kann, 
d.h. Profilmessungen, die auf derselben Maschine aber von verschiedenen Startpositionen aus gemacht 
wurden, können abgeglichen werden.

Profil um eine Lamelle / ein Segment nach links bewegen 

Profil um eine Lamelle / ein Segment nach rechts bewegen 

Profil zurück zur Ausgangsposition bewegen

Profil spiegeln

Bei 2 oder mehr Profilen wird das Profil dadurch an die höchste Lamelle / das 
höchste Segment angeglichen.

Bei 2 oder mehr Profilen wird das Profil dadurch an die niedrigste Lamelle / das 
niedrigste Segment angeglichen.
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Reading and Comparing Values

 When a chart is displayed it is possible to follow the profile and obtain specific information along the 
length of the profile; this can be done by placing the cross-hair at the required point and clicking the left 
mouse button. Once this is done a horizontal and vertical line will appear, and the values indicated by the 
cross-hair are displayed in the top right-hand corner of the chart 

 Note that the cross-hair can be moved by pressing the left and right arrows on the keyboard 

Adjusting Profiles

There are 6 different buttons available to allow the user to adjust the way in which the profiles are displayed 
and mean that profiles that were taken on the same machines, but from different starting positions, can be
aligned. 

Move the profile left by one bar/segment 

Move the profile right by one bar/segment 

Return the profile to its original position 

Mirroring the profile 

When there are 2 or more profiles this aligns the profile to 
the highest bar/segment 

When there are 2 or more profiles this aligns the profile to 
the lowest bar/segment
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Zooming behaviour 

 Zooming is only possible in the Chart and Radial tabs. To zoom in on any part of a chart: 
1. Left-click a place on the left side of the chart section you wish to zoom. 
2. Hold down the mouse button while you drag a rectangle across and down to the right. 
3. Release the mouse button to perform the zoom. To zoom in horizontally: 
4. Proceed as above, but only move the mouse directly left or right to select the area to be enlarged. Two

vertical lines will be displayed across the chart to indicate the selection. 
Tozoominvertically:
1. Proceed as above, but only move the mouse directly up or down to select the area to be enlarged. Two 

horizontal lines will be displayed across the chart to indicate the selection. 
 To zoom out from any view:

1. Left-click any place in the chart and drag a rectangle across and up to the left to display a rectangle with
a cross in it. When you release the mouse button the chart will return to its original size and location. 

Alarms 

The PC-Software can check the commutator and slip ring recordings for the following alarm conditions. If the 

button is in colour  then it will indicate that an alarm has been triggered on the selected profile, if black 

and white then no alarms are triggered:

 TIR - Total Indicated Runout 
ñ  The difference between the highest and lowest points on the profile. 

MBTB - Maximum Bar-to-bar
ñ  The difference in height between adjacent commutator bars. 

MSTS - Maximum Segment to segment 
ñ  The difference in height between adjacent slip ring segments. 

High Mica
ñ  Lists anyMica insulation (between commutator bars) which are not recessed below the bar

surface. 

Downloading .Mas files

It is possible to download profiles taken on the previous version of the profiler that Morgan used to offer; this 
can be done by selecting ì File>Importing MAS FileÖ î  and following the on-screen instructions. 

Zoomverhalten

• �    �Zoomen ist nur in den Registerkarten Tabelle und Radial möglich. Größer zoomen in jedem Teil der 
Tabelle:
1. �Machen Sie einen Linksklick auf eine Stelle auf der linken Seite des Tabellenabschnitts, den Sie 

zoomen möchten.
2. �Halten Sie die Maustaste gedrückt und ziehen Sie ein Rechteck über die Tabelle und nach unten 

rechts.
3. Zum Zoomen lassen Sie die Maustaste los. Horizontal größer zoomen:
4. �Gehen Sie wie oben beschrieben vor, aber bewegen Sie die Maus direkt nach links oder rechts, um 

den zuvergrößernden Bereich auszuwählen. Es erscheinen über die ganze Tabelle zwei vertikale 
Linien, die Ihre Auswahlanzeigen.

• �    �Vertikal größer zoomen:
1. �Gehen Sie wie oben beschrieben vor, aber bewegen Sie die Maus direkt auf und ab, um den zu 

vergrößernden Bereich auszuwählen. Es erscheinen über die ganze Tabelle zwei horizontale Linien, 
die Ihre Auswahl anzeigen.

• �    �Aus jeder Ansicht kleiner zoomen:
1. �Drücken Sie irgendwo in der Tabelle die linke Maustaste und ziehen Sie ein Rechteck über die 

Tabelle und hochnach links. Es erscheint ein Rechteck mit einem Kreuz darin. Wenn Sie die 
Maustaste loslassen, kehrt die Tabelle zuihrer ursprünglichen Größe und Position zurück.

Alarme

Die PC-Software kann die Aufzeichnungen des Kommutators und Schleifrings auf folgende 

Alarmbedingungen  überprüfen. Eine farbige Schaltfläche zeigt an, dass ein Alarm auf dem 

ausgewählten Profil ausgelöst wurde; ist die Schaltfläche schwarz und weit,  dann wurde kein Alarm 
ausgelöst: 

• TIR - Rundlaufabweichung
– Differenz zwischen den höchsten und den niedrigsten Punkten auf dem Profil

• MBTB - Maximum von Lamelle zu Lamelle
– Höhendifferenz zwischen angrenzenden Kommutatorlamellen

• MSTS - Maximum von Segment zu Segment
– Höhendifferenz zwischen angrenzenden Schleifringsegmenten

• Mica-Höchstspannung
– �Listet jede Mica-Isolierung (zwischen den Kommutatorlamellen) auf, die unter der 

Lamellenoberfläche nicht vertieft ist.

.Mas-Dateien herunterladen

Man kann Profilmessungen herunterladen, die mit der Vorgängerversion des Profilmessgeräts von Morgan
gemacht wurden. Zu diesem Zweck wählt man “Datei>MAS-Datei importieren ...” aus und folgt den 
Bildschirmanweisungen.
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APPzSPECIFICATIONS

These specifications may be changed in future versions: 

52

www.morganadvancedmaterials.com 
Insert Registered Legal Entity name, address and number, or all other details as required to comply with regional regulations 52

APPENDIX B: WARRANTY & REPAIRS

Warranty 
The warranty covers construction and material faults of the MSPro14 equipment and the warranty period is 
valid for 1 year after invoicing.  

Damage due to incorrect or inexpert handling is excluded from the warranty. Do not open the housing of the 
MSPro14 unit yourself as this will invalidate the warranty.

Repairs & Calibration 
Repairs can and will be done by (or under the authority of) the developer/manufacturer; this can also be 
done elsewhere but this is at the Users own risk.

In the unlikely event that repairs are necessary please contact your local Morgan sales office. They can 
inform you on how to proceed. You can contact them as well if you want to have your MSPro14 calibrated. 

Diese Spezifikationen können in künftigen Versionen geändert werden:

ANHANG A: SPEZIFIKATIONEN
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APPENDIX B: WARRANTY & REPAIRS

Warranty 
The warranty covers construction and material faults of the MSPro14 equipment and the warranty period is 
valid for 1 year after invoicing.  

Damage due to incorrect or inexpert handling is excluded from the warranty. Do not open the housing of the 
MSPro14 unit yourself as this will invalidate the warranty.

Repairs & Calibration 
Repairs can and will be done by (or under the authority of) the developer/manufacturer; this can also be 
done elsewhere but this is at the Users own risk.

In the unlikely event that repairs are necessary please contact your local Morgan sales office. They can 
inform you on how to proceed. You can contact them as well if you want to have your MSPro14 calibrated. 

ANHANG A: GARANTIE & REPARATUREN

Garantie

Die Garantie deckt Konstruktions- und Materialfehler der MSPro14-Geräte ab und ist für 1 Jahr ab 
Rechnungsstellung gültig.

Schäden aufgrund von falscher oder unsachgemäßer Handhabung sind von der Garantie ausgenommen. 
Das eigenständige Öffnen MSPro14-Gehäuses hat ein Außerkraftsetzen der Garantie zur Folge.

Reparaturen & Kalibrierung

Reparaturen können und werden durch den Entwickler/Hersteller (oder in dessen Auftrag) durchgeführt. 
Reparaturen können anderen Personen durchgeführt werden. Das geschieht dann aber auf eigenes 
Risiko des Anwenders.

Sollten wider Erwarten Reparaturen erforderlich werden, wenden Sie sich bitte an die örtliche 
Verkaufsniederlassung von Morgan. erfahren Sie, was zu tun ist. Sie können sich auch an Ihre örtliche 
Verkaufsniederlassung wenden, wenn Ihr MSPro14 kalibriert
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